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P/TV01   VIDEO SETUP 

H/W SUMMARY 

      P/TV01 
VIDEO SETUP   

WLES A31p

SSV BNC to
BNC Cable

SSV to PDIP/CIP Cable

Bal/Unbal

Video

Video A (PAYLOAD)

SSV DC Pwr Cable (6 ft)

Pwr

PAYLOAD DATA INTERFACE PANEL 2 (L11)

CABIN P/L
J105 J107J101 J103DC1 DC2

(Not
Used)

Video Spare 1
(Gnd cntl)

SSV Compression Encoder BoxSSVTCS

Photoflood

Loc-Line
(w/Clamp)

AC UTIL
PWR AC1
F1(MO52J)

Digital CC Vid/Pwr Cable (15 ft)

RCA Barrel Adapter

A/V
Adapter
Cable

Wide
Conversion

Lens

Multiuse
Arm

VideoPwr

FD CC

Digital CC Vid/Pwr Cable (15 ft)

Pwr

RCA Barrel Adapter

A/V
Adapter
Cable

Multiuse
Arm

MD CC

J2
SYNC
J4

J6
MD

AVIU

J1
75
J5

LO
J3
J7

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Pwr
DTV
AVIU

DTV
V10

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

VideoAVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

AVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Video

WVS
2

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 2
AVIU

R
L
V

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
MON 1
AVIU

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

DTV Audio Cable

AVIU-CC Video Cable

jsc48038_120_001r5.cvx

SEC
C/L

LDRI/
ITVC

VIDEO PROCESSING UNIT

3

ON

OFFCB1

RSC VIDEO

J101 J103 J105 J107

OPP

R12

RSC Video Cable

WVS 1 TV Pwr Cable (20 ft)

WVS 2 TV Pwr Cable (20 ft)

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

PCMCIA to
WIB-Remote
Cable (6 ft)

RS-422 PCMCIA
Card/Cable Assy

FD CC TV
Pwr Cable

(10 ft)

WLES
A31p

ASC (DTV/ENT) TV Pwr Cable (10 ft)

Pwr,Sync MD TV Pwr Cable (20 ft) Video

A31p Video
Adapter

LCS Video Cable

Balanced Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

AVIU Adapter
Cable

BPSMU to CCU
Adapter Cable

Video

*

*For CC: PWR - LO
For Mini-Cam: PWR - HI

OPP-LCC
Cable

MON 2 VPU Cable

MHA MS
CCU

PLAY
WVS 2

ATU RecorderREC

PLAY

REC

Comm Cable
(4 ft)

Comm Cable
(4 ft)

WVS 1
ATU Recorder

BNC-RCA
Phono AdapterRCA Barrel

Adapter

MON 1 to RWS Cable

BNC-RCA
Phono Adapter

RCA Barrel
Adapter

MON 2 to RWS Cable

Connect to
CCTV P/L 3

as reqd
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 P/TV01   VIDEO SETUP (Continued) 

SETUP 

NOTE 
Steps 1-7 minimum rqmt for FD2 OBSS TPS Inspection  

 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd  
 2. Perform DTV Setup  
O19 TV PWR – OFF  
L10:A1 Unstow AVIU and disconnect following cables: 

ASC (DTV/ENT) TV Pwr Cable from J2 
ASC/HUD Mini-Cam Cable from J5 
Mini-Cam BNC Video Cable from J1 

A15 Connect DTV Audio Cable to PS CCU 
Config DTV H/W per H/W SUMMARY, pg 1-4  
Config Panels 

L10 (MUX) √VTR/CC PWR – on (LED on) 
If dnlk: 

MUX/VTR/CC PWR – on (LED on) 
√MUX BYPASS – ACT  

L10 (VIP) √ATU – REC 
√CCTV VIDEO IN – J3 
√PWR – on (LED on)  

L10 (VTR) √ON/STANDBY LED – green 
√Switches set to White Dot (seven) 
√COUNTER SELECT – COUNTER (TC)  
Config DTV V10 

AVIU (DTV) √SYNC/VIDEO – VIDEO 
HI-Z/75 – 75 
PWR SELECT – LO  

O19 TV PWR – ON  
V10 PWR – ON 

MENU pb – push 
SEL COMMANDER 
SEL – OFF 
MENU pb – push  

L9 Config PS ATU per Comm Plan 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 3. Perform MON 1,2 V10 Setup 
 

MF57M Remove MON 1,2 Desk Assy Hardware from Stow-N-Go CTB 
 

O19 TV PWR – OFF 
 

Config MON 1,2 V10s and Cables per H/W SUMMARY, pg 1-4 
Connect: 

MON 1,2 Digital CC Vid/Pwr Cables to MON 1,2 V10s 
MON 1,2 AVIU-CC Video Cables to MON 1,2 V10s 
Multiuse Brkt to desk 
MON 1 AVIU Cable to MON 1 AVIU J4 
MON 2 Balanced Video Cable to MON 2 AVIU J4 
MON 1,2 TV PWR Cable to MON 1,2 AVIU J2 
Multiuse Brkt to wall 

 
AVIU (MON 1,2) √SYNC/VIDEO – VIDEO 

√HI-Z/75 – 75 
√PWR SELECT – LO 

 
O19 TV PWR – ON 
V10 (MON 1,2) PWR – ON 

DISPLAY pb – Toggle to display tape counter 
√Tape installed 

R12 (VPU) VPU PWR – ON (LED on) 
 

 4. √RSC Video Cable connected between R12/OPP-RSC Video (J105) and R12/VPU-CCTV PL3 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 5. Perform Analog Camcorder Setup for FD,MD per H/W SUMMARY, pg 1-4, as reqd 
 

O19,MO58F TV PWR – OFF 
 

AVIU (FD,MD) SYNC/VIDEO – VIDEO 
HI-Z/75 – 75 
PWR SELECT – LO 

 
O19,MO58F TV PWR – ON 

 
CC Install Wide Conversion lens 

PWR – CAMERA 
√Tape installed 
√Viewfinder (LCD) displays STBY 
Camr Settings: 
√AUTO LOCK – AUTO LOCK 
√FOCUS – AUTO 

Install Audio Muting Plug (optional) 
Install Multiuse Brkt 
PWR – OFF 

 
 6. Perform LCS Cable Connections per H/W SUMMARY, pg 1-4, as reqd 

 
A17 If MD Camcorder setup not performed, unstow MD AVIU from Camcorder Bag 

 
Middeck Connect end of LCS Video Cable to MD AVIU J1 
AVIU (MD) √HI-Z/75 – 75 
Flt Deck Connect other end of LCS Video Cable (A31p Video Adapter) to PGSC A31p Video Out port via PGSC Usage Chart 

Connect OPP-LCC Cable to PGSC RJ45 Ethernet port via PGSC Usage Chart 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 7. Perform SSV Setup 
 

MA16L Unstow SSV Compression Encoder Box 
 

Config SSV H/W per H/W SUMMARY, pg 1-4 
 

NOTE 
Video Spare 1 controlled by MCC instead of pnl A7 

 
L12 (SSP 2) √PDIP 2 PWR 1 (CB3) – cl 
L11 (PDIP 2) DC PWR 1 – ON 

 
Config SSV settings 

SSV IN SEL – NTSC 
Mode – 3 
OUTRATE – 4 
SSV Pwr – on 
√Pwr LED illum 
√ENC DATA LED flickering 
√FRM DATA LED flickering 
√FILL FRM pulsing 

 
Inform MCC when SSV SETUP complete 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 8. Perform WVS Setup 

 a. Activate WVS System  
A7  WIRELESS VID HTR – ON 

WIRELESS VID PWR – ON  
MO58F  TV PWR – OFF 

 
 b. Remove WVS Hardware from Stow-N-Go CTB  

Config WVS 1,2 V10s and Cables per H/W SUMMARY, pg 1-4 
Connect: 

WVS 1,2 Digital CC Vid/Pwr Cables to WVS 1,2 V10s 
WVS 1,2 AVIU-CC Vid Cables to WVS 1,2 V10s 
Multiuse Brkt to desk 
Pre-routed WVS 1,2 Balanced Video Cables from R12/VPU XCVR 1,2 BAL  to WVS 1,2 AVIU J4 
Pre-routed WVS TV Pwr Cables to WVS 1,2 AVIU J2 
Balanced Video Cables stowed on WVS Stow-N-Go desk to WVS 1,2 AVIU J6 
ATU Recorder Cables to left (white) port per H/W SUMMARY, pg 1-4 
Multiuse Brkt to wall 
PCMCIA-to-WIB Remote Cable to R12/WIB J701 
RS-422 PCMCIA Card/Cable Assy to pre-routed PCMCIA-to-WIB Remote Cable A31p per PGSC Usage Chart  

AVIU (WVS 1,2)  √SYNC/VIDEO – VIDEO 
√HI-Z/75 – 75 
√PWR SELECT – LO  

V10 (two) 
MO58F  TV PWR – ON 
V10 (WVS 1,2)  PWR – ON 

√Tape installed 
√WVS Test Pattern displayed (color bars w/”No WVS Video”) 

PWR – OFF  
A11  Config MS ATU/CCU per Comm Plan 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 8. Perform WVS Setup (Continued) 
 

 c. WVS PGSC Prep 
 

PGSC Pwrup and Application Opening 
PGSC  √Pwr – ON 

Sel Shuttle Apps icon 
Sel WVS icon 

 
Sel ‘No’ at ‘Restore To Previous Settings:’ window 

 
If ‘Comm Port Configuration’ error displayed: 

Remove Quatech RS-422 Card 
Sel ‘Start’> ‘Shut Down’> ‘Shut Down’> ‘OK’ 
Reinstall Quatech RS-422 Card 
Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 

RF Camera page will appear 
 

Application Setup 
If ‘Static XCVR’(‘Bad Camera ID’,‘Temp Alert’,‘Temp Caution’) alert msg: 

Perform ALERT MSG TROUBLESHOOTING (Cue Card, WVS) 
If ‘Static RF Camera’ alert msg: 

Disregard 
Sel ‘File’ → ‘Assign Camera ID’ 
Verify following: 

 
Camr Address S/N In Use Label 

16 1010 1 EV1 
18 1007 1 EV2 

 
When complete, sel ‘OK’ 
If Camr IDs not correct: 

Sel ‘Delete Entry’ until all deleted 
Perform CAMR ID ASSIGNMENT (Cue Card, WVS) as reqd 
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P/TV01   VIDEO SETUP (Concluded) 

SETUP (Concluded) 

 8. Perform WVS Setup (Concluded) 
 

 c. WVS PGSC Prep (Concluded)  
Application Setup (Concluded)  
Sel ‘File’ → ‘Advanced Controls’ 
On XVCR tab: 
√IF – selected 
√Other options not selected 

Sel RF Camera tab: 
√Power Selections – selected 
√Automatic Gain Control – selected 
√S-Band Level – selected 
√Other options not selected 

When complete, sel ‘OK’ 
 

 d. PWRDN  
Sel ‘File’ → ‘Exit’ 

A7  WIRELESS VID PWR – OFF 
WIRELESS VID HTR – OFF 

 
MA16L 9. Unstow, set up BPSMU w/BPSMU to CCU Adapter Cable at CDR CCU 
  Connect BPSMU Batt 

 
 10. Perform Mini-Cam Setup for Rndz Views H/W SUMMARY, pg 1-4   

√LCS Video Cable not in use for Inspection activities  
AVIU (MD) Remove LCS Video Cable from J1  

SYNC/VIDEO – SYNC 
√HI-Z/75 – 75 
PWR SELECT – HI  

Mini-Cam Lens – 3.5mm 
Aperture – Adjust per MON view 
Stow Rear Window Bracket (W9) in DTV Bag 
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    P/TV02 
DOCK     
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P/TV02   DOCK 

H/W SUMMARY 

 

    P/TV02 
DOCK     

Digital CC Vid/Pwr Cable (15 ft)

RCA Barrel Adapter

A/V
Adapter
Cable

Wide
Conversion

Lens

Multiuse
Arm

VideoPwr

FD CC

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Pwr
DTV
AVIU

DTV
V10

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

DTV Audio Cable

AVIU-CC Video Cable

jsc48038_120_002r1.cvx

SEC
C/L

Sec
C/L

VIDEO PROCESSING UNIT

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

FD CC TV
Pwr Cable

(10 ft)

ASC (DTV/ENT) TV Pwr Cable (10 ft)

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

MON 1
AVIU

J2
SYNC
J4

J6
MD

AVIU

J1
75
J5
HI
J3
J7

AVIU Adapter
Cable

MON 2 VPU Cable

VideoMD TV Pwr Cable (20 ft)

Digital CC Vid/Pwr
Cable (15 ft)

WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

(Not
Used)

WVS TV Pwr Cable (20 ft)

BNC Barrel Adapter

AVIU-CC Video Cable



 FS 1-15 P/TV/120/FIN A 

P/TV02   DOCK (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining video, still photos of ISS rndz,docking 
 

SETUP 

 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 
 

 2. Perform 760 PROGRAM w/FLASH for in-cabin imagery 
 

Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 

ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct 
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P/TV02   DOCK (Continued) 

SETUP (Continued) 

 3. Perform 760 SHUTTER PRIORITY for docking/external imagery 
 

Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 

ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – S 

SS – 500 
AF Area Mode – [   ] (no “+”) 
 

NOTE 
For Docking:  Meter – Spot/Matrix 

 
Meter – Matrix (Spot when ISS <1/2 frame) 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – OFF 
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P/TV02   DOCK (Continued) 

SETUP (Concluded) 

 4. Perform Mini-Cam Setup for Rndz per H/W SUMMARY, pg 1-14, as reqd 
 

A17 CC Bag Obtain BNC Barrel Adaptor, AVIU – CC Video Cable 
AVIU (MD) Remove LCS Video Cable from J1 

√SYNC/VIDEO – SYNC 
√HI-Z/75 – 75 
PWR SELECT – HI 

 
Mini-Cam √Lens – 3.5mm 

Aperture – Adjust per monitor views 
 

 5. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19,MO58F √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
√Green Jumper – SEC C/L 
√SEC C/L Cap installed  

V10 PWR – ON 
 (MON 1,2, DTV) 
 WVS 1 

√Tape installed 
DISPLAY pb – Toggle to display tape counter  

FD CC PWR – CAMERA 
√Tape installed 
√Viewfinder (LCD) displays STBY 
Camr Settings 
√AUTO LOCK – AUTO LOCK 
√FOCUS – AUTO  

L10 (MUX) VTR/CC PWR – on (LED on) 
If dnlk, MUX/VTR/CC PWR – on (LED on) 

L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
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P/TV02   DOCK (Continued) 

OPS 

Still Imagery Video √ Item # 
Track # Rqmts 

DCS PLB CC Dnlk 
Notes 

 1. 
 

10A-5 

PAO Coverage 760 
28-70mm 
If exterior: 

Flash ON/OFF – OFF 

As desired PD100 
Tape installed 

LIVE 
(If avail) 

Plan for end of day crew 
choice video,DCS 

Rendezvous 
• Overall 
• Closeup 
• Damage 

 2. 
 

10A-1 

• Deterioration 

760 (Shutter) 
400mm(80-200mm) 
Flash ON/OFF – OFF 
 

A(B,C,D), ELB PD100 
As desired 

 Map ISS surfaces w/10% 
overlap 

Approach,Dock 
• Docking Target 
• Mating Surfaces 

 3. 
 

10A-1 

• TCS Planar Retro 
Reflectors 

760 (Shutter) 
400mm(80-200mm) 
Flash ON/OFF – OFF 

C/L 
Per RNDZ 
 
A(D) 
Per RNDZ 
 
C(B) 
Docking view 

PD100 
As desired 

 Rcd video thru hard dock 
Continually √focus sharpness 
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P/TV02   DOCK (Continued) 

OPS (Continued) 

 

APPROACH/DOCKING RQMTS

Mapping of ISS Module Surfaces

PMA2 APDS Area

C/L Camr

Camr A(D)

Camr C(B)

170 ft 30 ft
D
O
C
K
E
D

O
P
S

MON 1

MON 2

7 ft
Dock500 ft

Docking View

Range
Ruler

200 ft

w/80-200mm Lens
DCS 760 Camr

(Shutter)

400 ft

DCS 760 Camr
w/400mm Lens

(Shutter)

NOTE
Spot metering when ISS
modules < 1/2 frame

jsc48038_120_003.cvx

PAO Views
DCS 760 Camr

w/28-70mm Lens
(Shutter)
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P/TV02   DOCK (Concluded) 

OPS (Concluded) 

If operations temporarily suspended, perform DEACTIVATION as reqd 
If operations completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. DCS 760 
√Exp Mode – P 
Film Adv – S 
Pwr – OFF 
Flash ON/OFF – ON 
Start batt recharge as reqd 

 
 2. TV System 
R12 (VPU) √Green Jumper – SEC C/L 

√SEC C/L Cap installed 
√VPU PWR – ON (LED on) 

A7 VID OUT MON 1 pb – push 
VID IN PL2(VPU) pb – push 
CAMR CMD IRIS – CL 

L12 (SSP 2) C/L CAM PWR – OFF 
 

ODS Remove, stow C/L camr, Harness Assy, Bridge 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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  P/TV03 
UNDOCK       



 FS 1-22 P/TV/120/FIN A 

P/TV03   UNDOCK 

H/W SUMMARY 

 

  P/TV03 
UNDOCK       

Digital CC Vid/Pwr Cable (15 ft)

RCA Barrel Adapter

A/V
Adapter
Cable

Wide
Conversion

Lens

Multiuse
Arm

VideoPwr

FD CC

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Pwr
DTV
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DTV
V10
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J6

J1
75
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LO
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J7

R
L
V

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

DTV Audio Cable

AVIU-CC Video Cable

jsc48038_120_002r1.cvx

SEC
C/L

Sec
C/L

VIDEO PROCESSING UNIT

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

FD CC TV
Pwr Cable

(10 ft)

ASC (DTV/ENT) TV Pwr Cable (10 ft)

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

MON 1
AVIU

J2
SYNC
J4

J6
MD

AVIU

J1
75
J5
HI
J3
J7

AVIU Adapter
Cable

MON 2 VPU Cable

VideoMD TV Pwr Cable (20 ft)

Digital CC Vid/Pwr
Cable (15 ft)

WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

(Not
Used)

WVS TV Pwr Cable (20 ft)

BNC Barrel Adapter

AVIU-CC Video Cable



 FS 1-23 P/TV/120/FIN A 

P/TV03   UNDOCK (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining video, still photos of ISS undocking,flyaround 
 

SETUP 
 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 

 
 2. Perform 760 PROGRAM w/FLASH for in-cabin imagery 

 
Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 

ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 

 
 3. Perform 760 PROGRAM w/FLASH for in-cabin imagery (Concluded)  

Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct  
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P/TV03   UNDOCK (Continued) 

SETUP (Continued) 
 4. Perform 760 SHUTTER PRIORITY for undocking/external imagery 

 
Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 

ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – S 

SS – 500 
AF Area Mode – [   ] (no “+”) 

 
NOTE 

For Undocking:  Meter – Matrix/Spot 
 

Meter – Matrix (Spot when ISS <1/2 frame) 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – OFF 
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P/TV03   UNDOCK (Continued) 

SETUP (Concluded) 
 5. Perform Mini-Cam Setup for Rndz per H/W SUMMARY, pg 1-22, as reqd 

 
AVIU (MD) Remove LCS Video Cable from J1, if connected 

√SYNC/VIDEO – SYNC 
√HI-Z/75 – 75 
PWR SELECT – HI 

 
Mini-Cam Lens – 3.5mm 

Aperture – Adjust per monitor views 
 

 6. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19 √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
√Green Jumper – SEC C/L 
√SEC C/L Cap installed 

 
V10 PWR  – ON 
 (MON 1,2, DTV) 
 WVS 1 
 

√Tape installed 
DISPLAY pb – Toggle to display tape counter 

 
FD CC PWR – CAMERA 

√Tape installed 
√Viewfinder (LCD) displays STBY 
Camr Settings 
√AUTO LOCK – AUTO LOCK 
√FOCUS – AUTO 

 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
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P/TV03   UNDOCK (Continued) 

OPS 

Still Imagery Video √ Item # 
Track # Rqmts 

DCS PLB CC Dnlk 
Notes 

 1. 
 

10A-5 

PAO Coverage 760 
28-70mm 
If exterior: 

Flash ON/OFF – OFF 

As desired PD100 
Tape installed 

LIVE 
(If avail) 

Plan for end of day crew 
choice video,DCS 

Undock and Flyaround 
• Docking Tgt/Mating 

Surfaces 

A(D) 
Per RNDZ 

 

• TCS Planar Retro 
Reflectors 

• Surfaces 
• Solar Panels 
• Handrails 
• SVS Targets 
 
• SM Thrusters on Zenith, 

near aft end 
• Trusses including rads/ 

baseplates and SAWs 
(in/outboard SABB 
insulation degradation) 

 2. 
 

10A-2 
10A-3 
10A-4 

• Node 2 

760 (Shutter) 
80-200mm(400mm) 
Flash ON/OFF – OFF 
 

C/L 
Docking tgt and 

PAO view 

 
 

LIVE 
(If avail) 

Map ISS surfaces w/10% 
overlap 
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P/TV03   UNDOCK (Continued) 

OPS (Continued) 

 

UNDOCKING/FLYAROUND RQMTS

PMA2 APDS Area

Mapping of ISS Module Surfaces

C/L Camr

Camr C

Camr A(D) (flyaround at 400 ft)

400 ft200 ft30 ftD
O
C
K
E
D

O
P
S

100 ft

DCS 760 Camr
w/80-200mm Lens

(Shutter)

MON 1

DCS 760 Camr
w/400mm Lens

(Shutter)

DTV

(At 400 ft only)

NOTE
Spot metering when ISS
modules < 1/2 frame

jsc48038_120_004.cvx

Camr A(D)MON 2

PAO ViewsDCS 760 Camr
w/28-70mm Lens

(Shutter)
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P/TV03   UNDOCK (Concluded) 

OPS (Concluded) 

If operations temporarily suspended, perform DEACTIVATION as reqd 
If operations completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. DCS 760 
√EXP Mode – P 
Film Adv – S 
Pwr – OFF 
Flash ON/OFF – ON 
Start batt recharge as reqd 

 
 2. TV System 
R12 (VPU) √Green Jumper – SEC C/L 

√SEC C/L Cap installed 
√VPU PWR – ON (LED ON) 

A7U VID OUT MON 1 pb – push 
VID IN PL2(VPU) pb – push 
CAMR CMD IRIS – CL 

L12 (SSP 2) C/L CAM PWR – OFF 
 

ODS Remove, stow C/L Camr, Harness Assy 
Go to DEACTIVATION (Cue Card, TV) as reqd 

 



 FS 1-29 P/TV/120/FIN A 

 

This Page Intentionally Blank 

P/TV04 
INGR/EGR         



 FS 1-30 P/TV/120/FIN A 

P/TV04   INGRESS/EGRESS 

H/W SUMMARY 

INGRESS TV CONFIG 

 

P/TV04 
INGR/EGR         

jsc48038_120_005.cvx

MD CC A/V
Wide

Conversion
Lens

Wireless Video System
Interface Box

VIDEO PROCESSING UNIT

(R12)

ISS

Batt CCTV PL3



 FS 1-31 P/TV/120/FIN A 

P/TV04   INGRESS/EGRESS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for documenting ISS ingress/egress w/video and still photos 
 

SETUP 
 1. Config ISS Video 

 
 Perform ACTIVATION (Cue Card, TV) for DNLK OPS of ISS signal as reqd 
R12 (VPU) Green Jumper – ISS 

√VPU PWR – ON 
 

A7 VID OUT DNLK pb – push 
VID IN PL2(VPU) pb – push 

 
 2. Perform Ingress Camcorder Setup 

 
A17 Acquire two batts, one for Camcorder and one spare 
PD100 PWR – CAMERA 

Install Batt 
Install tape 
√Viewfinder (LCD) displays STBY 
Camr Settings 
√AUTO LOCK – AUTO LOCK 
√FOCUS – AUTO 

√Audio Muting Plug removed 
 

 3. Perform 760 PROGRAM w/FLASH 
 

Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 

ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 



 FS 1-32 P/TV/120/FIN A 

P/TV04   INGRESS/EGRESS (Concluded) 

SETUP (Concluded) 
 3. Perform 760 PROGRAM w/FLASH (Concluded) 

 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct 

 
OPS 

Still Imagery Video Notes √ Item # 
Track # Rqmts 

DCS PLB CC Dnlk  
 1. 

 
10A-5 

Hatch Opening, Ingress 
Hatch Close, Egress 

760 
28-70mm 

 
 

PD100 
 

LIVE 
(if avail) 

 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. DCS 760 
Pwr – OFF 
Start batt recharge as reqd 

 
 2. TV System 

Go to DEACTIVATION (Cue Card, TV) as reqd 
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        P/TV05 
ISS INT OPS 



 FS 1-34 P/TV/120/FIN A 

P/TV05   ISS INTERNAL OPS 

H/W SUMMARY 

 

        P/TV05 
ISS INT OPS 

44 ft BPSMU
Audio #1 Cable

jsc48038_120_006a.cvx

42 ft BPSMU
Audio #1 Cable

BPSMU
N/A

35 ft BPSMU
Audio #1 Cable

RWS 1,2 Drag-Thru
Cables

Shuttle Half

Station Half

BPSMU
1

BPSMU
2

Video
1

Video
2

Drag-Through QD Box

BPSMU
1

BPSMU
2

Video
1

Video
2

RWS 1,2
Drag-Thru

Cables

44 ft BPSMU
Audio #2 Cable

35 ft BPSMU
Audio #2 Cable

42 ft BPSMU
Audio #2 Cable

BPSMU

To Shuttle

RWS
V10

R
L
V

RWS
V10

R
L
V
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P/TV05   ISS INTERNAL OPS (Continued) 

H/W SUMMARY (Concluded)  

 

Wireless Video System
Interface Box

VIDEO PROCESSING UNIT

(R12)

ISS
CCTV PL3

jsc48038_120_006br2.cvx

R12

RWS 1,2
Drag-Thru

Cables

RWS 1,2
Drag-Thru

Cables

BPSMU to CCU
Adapter Cable

(ODS)
TV

4 ft BPSMU 1,2
Audio Cables

BPSMU/ODS
Adapters

N/A

N/A

N/A

N/A

22 ft BPSMU
Audio #1 Cable22 ft BPSMU

Audio #2 Cable

To Station
and

Drag-Through QD Box

MON 1
AVIU

J5

BNC-RCA
Phono Adapter

RCA Barrel
Adapter

MON 1 to
RWS Cable

RWS 1
Vid Cable

RWS 1
Vid Cable



 FS 1-36 P/TV/120/FIN A 

P/TV05   ISS INTERNAL OPS (Continued) 
SCENE SYNOPSIS 

Scene contains procedures for setup, documenting ISS internal ops (surveys, PAO events, logistics, transfers, closeouts)  
w/video,still photos  

SETUP 

WARNING 
Locate QDs at hatches for ease in locating,disconnecting during hatch closure.  
Route,restrain cables to prevent loose cable lengths which could entrap crew 

 
 1. Config H/W per H/W SUMMARY, pgs 1-34 and 1-35  

Prior to Docking 
Config RWS Vid Cables: 

R12 (VPU)  √RWS 1 BNC Vid Cable connected to XCVR 1 Unbal on WIB 
Disconnect RWS 2 BNC Vid Cable from XCVR 2 Unbal on WIB 

MON 1,2  √MON 1 to RWS Cable connected to MON 1 AVIU J5 
(Stow n Go) 

Connect RWS 2 BNC Vid Cable to MON 1 to RWS Cable 
Middeck  Place two RWS Drag-Thru Cables near ODS/PMA2 hatch  

Post Docking 
Config BPSMU and RWS Cables: 

ODS/PMA2  Connect orbiter RWS 1,2 cables to Drag-Through QD Box 
Connect BPSMU Cables (two) to orbiter A/L CCU 1,2  

If V10: 
√Pwr configured per P/TV121 DOCKED OPERATIONS, dwg USOS 120VDC –V10 VTRs (SODF: ISS PTV: SCENES) 

V10 (RWS 1,2)  PWR– ON 
If A31p: 
√Drag-Thru Cable connected to A31p Video Adapter 

A31p  √PWR (two) – ON 
Sel 'Station Apps : COSS Apps : Video Converter' 

√'Video Converter' window displayed 
Sel 'Set Properties' 

√'Video Settings' window displayed 
Format: – NTSC 
Close 'Video Settings' window 
Sel 'Local Full Screen' 
Press 'ESC' or 'W' to minimize display as reqd   
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P/TV05   ISS INTERNAL OPS (Continued) 

SETUP (Concluded) 

PAO EVENT 

 1. Config VPU 
 

R12 (VPU) √Green Jumper – ISS 
√VPU PWR – ON (LED on) 

 
 2. Config Shuttle Video 

 
A7 VID OUT DNLK pb – push 

VID IN PL2(VPU) pb – push  
STILL CAMR 

 1. Perform 760 PROGRAM w/FLASH (DCS 760, REF PROC)  
OPS 

Still Imagery Video Notes √ Item # 
Track # Rqmts 

DCS PLB CC Dnlk  
General ISS IVA Activity 

• PAO Scenes of Interest 
• Crew Photo 

Plan for end of day crew 
choice video, DCS 

• Crew Rotation 
– IELK Install 

 1. 
 

10A-4 
10A-5 

 

– Sokol Suit Check 

760 
28-70mm 
For Crew Photo: 

Perform 760 CREW 
PHOTO (DCS 760, 
REF PROC) 

 
 

ISS PD100 
 

LIVE 
(if avail) 

Crewmember rotation IELK 
install and Sokol suit 
checkout 

Node 2 Imagery  2. 
 

10A-29 
 

• Obtain imagery of Node 2 
internal outfitting 

760 
28-70mm 
 

 ISS PD100 
 

LIVE 
(if avail) 

IVA video w/live dnlk or 
recorded playback 

 
Dnlk DCS imagery 

ODS/PMA2 
Drag through Config 

 3. 
 

10A-32 
 

 

760 
28-70mm 
 

   Document Cables and hoses 
in ODS/PMA2 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 
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P/TV05   ISS INTERNAL OPS (Concluded) 

DEACTIVATION 

 1. DCS 760 
Pwr – OFF 
Start batt recharge as reqd 

 
 2. Drag-Through QD Box 

Disconnect RWS Cables (two) from orbiter side Video 1,2 ports.  Stow cables on orbiter 
Disconnect BPSMU Cables from ODS CCU ports; coil as reqd 
Transfer Drag-Through QD Box and remaining attached cables to ISS 

 
 3. TV System 

Go to DEACTIVATION (Cue Card, TV) as reqd 
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      P/TV06 
SSRMS   



 FS 1-40 P/TV/120/FIN A 

P/TV06   SSRMS 

H/W SUMMARY 

 

      P/TV06 
SSRMS   
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Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R

L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

MON 1
AVIUMON 2 VPU Cable



 FS 1-41 P/TV/120/FIN A 

P/TV06   SSRMS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining video of SSRMS activities 
 

SETUP 

 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 
 

 2. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19 √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
Green Jumper – ISS 

 
V10 PWR – ON 
 (MON 1,2, DTV) 

√Tape installed 
DISPLAY pb – Toggle to display tape counter 

 
FD CC PWR – CAMERA 

√Tape installed 
√Viewfinder (LCD) displays STBY 
Camr Settings 
√AUTO LOCK – AUTO LOCK 
√FOCUS – AUTO 

 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
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P/TV06   SSRMS (Concluded) 

OPS 

Still Imagery Video √ Item # 
Track # Rqmts 

DCS PLB CC Dnlk 
Notes 

 1. 
 

10A-5 

PAO Coverage 760 
28-70mm 
If exterior: 

Flash ON/OFF – OFF 

As desired PD100 
Tape installed 

LIVE 
(If avail) 

Plan for end of day crew 
choice video,DCS 

SSRMS Camr Views 
 
 
 

 2. 
 
 

 

 A(B,C,D), ELB 
Per PDRS, 

ROBO 

   

 
If operations temporarily suspended, perform DEACTIVATION as reqd 
If operations completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. TV System 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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P/TV07   EVA 

H/W SUMMARY 

 

    P/TV07 
EVA     

Digital CC Vid/Pwr Cable (15 ft)

RCA Barrel Adapter

A/V
Adapter
Cable

Wide
Conversion

Lens

Multiuse
Arm

VideoPwr

FD CC

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Pwr
DTV
AVIU

DTV
V10

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

VideoAVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

AVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Video

WVS
2

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 2
AVIU

R
L
V

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
MON 1
AVIU

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

DTV Audio Cable

AVIU-CC Video Cable

jsc48038_120_007r4.cvx

LDRI/
ITVC

VIDEO PROCESSING UNIT

WVS TV Pwr Cable (20 ft)

WVS TV Pwr Cable (20 ft)

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

PCMCIA to
WIB-Remote
Cable (6 ft)

FD CC TV
Pwr Cable

(10 ft)

ASC (DTV/ENT) TV Pwr Cable (10 ft)

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

BNC Straight Adapters

RWS 2
VIU-CM
Cable

V10 pwr provided
from UOP6 via Dual
Canon Li-ION Batt

Charger Assy

RWS 1
VIU-CM
Cable

RWS 1
BNC Vid

Cable

RWS 1
BNC Vid

Cable

RWS 2
BNC Vid

Cable

Video 1

Video 2

Video 1

Video 2

BNC Straight Adapters

RWS 1
BNC Vid

Cable

Drag-Through
QD BoxRWS 2

BNC Vid
Cable

RWS 2
BNC Vid

Cable

J2
SYNC
J4

J6
MD

AVIU

J1
75
J5
HI
J3
J7

AVIU Adapter
Cable

EVA 2

MON 2 VPU Cable

Pwr,Sync MD TV Pwr Cable (20 ft) Video

RWS 2 BNC Vid Cable

MHA MS
CCU

PLAY
WVS 2

ATU RecorderREC

PLAY

REC

Comm Cable
(4 ft)

Comm Cable
(4 ft)

WVS 1
ATU Recorder

RS-422 PCMCIA
Card/Cable Assy

WLES
A31p

BNC-RCA
Phono Adapter RCA Barrel

Adapter

MON 1 to RWS Cable

Connect to
CCTV P/L 3

as reqd
BNC-RCA

Phono Adapter

RCA Barrel
Adapter

MON 2 to RWS Cable



 FS 1-45 P/TV/120/FIN A 

P/TV07   EVA (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for documenting ISS EVA and IVA ops w/video,still photos 
 

SETUP 

FOR ALL EVAs: 
 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 

 
 2. Perform 760 PROGRAM w/FLASH 

 
Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 

ISO – 100 
√BKT disabled 
√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct 
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P/TV07   EVA (Continued) 

SETUP (Continued) 

 3. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19, √TV PWR – ON 
 MO58F 

 
R12 (VPU) √VPU PWR – ON (LED on) 

√Green Jumper – LDRI/ITVC 
 

V10 PWR – ON 
 (DTV,MON 1,2, 
 WVS 1,2) 

√Tape installed 
DISPLAY pb – Toggle to display tape counter 

 
FD CC PWR – CAMERA 

√Tape installed 
√Viewfinder (LCD) displays STBY 
Camr Settings 
√AUTO LOCK – AUTO LOCK 
√FOCUS – AUTO 

 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
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P/TV07   EVA (Continued) 

SETUP (Continued) 

 4. Config WVS and PGSC 
 

 a. Activate WVS System  
A7  √WIRELESS VID HTR – ON 

WIRELESS VID √PWR – ON 
 

 b. WVS PGSC Prep  
PGSC Pwrup and Application Opening 

PGSC  Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 
Sel ‘No’ at ‘Restore To Previous Settings’ window  
If ‘Comm Port Configuration’ error displayed: 

Remove Quatech RS-422 Card 
Sel ‘Start’> ‘Shut Down’> ‘Shut Down’> ‘OK’ 
Reinstall Quatech RS-422 Card 
Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 

RF Camera page will appear  
NOTE 

During EVA prep, EMU TV assy will be pwrd 
 

Application Setup 
Select Page – XCVR 
Transceiver 1(2) CMD Power – ON (green CMD PWR:LVL- “ON:Min”) 
RF Camera 1 – One EVA crewmember (green “ON”) 
RF Camera 2 – Other EVA crewmember (green “ON”)  
If alert msg, perform ALERT MSG TROUBLESHOOTING (Cue Card, WVS)  
Select Page – RF CAMERA  
Near middle of RF Camera page, sel ‘Advanced Controls’  
For center lens on each RF Camr Assy: 

Lens Iris Cntl – op(cl) until good video on V10(MON)  
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P/TV07   EVA (Continued) 
SETUP (Concluded) 

If EVA 2: 
 5. Perform Mini-Cam setup for EVA fwd window view  
AVIU (MD) √SYNC/VIDEO – SYNC 

√HI-Z/75 – 75 
PWR SELECT – HI  

CAUTION 
To avoid window damage, do not allow hardware to come in contact with window 

 
Mini-Cam Connect Mini-Cam to W3/HUD Mini-cam extension cable away from window 

Lens – 6mm 
Aperture – Adjust per MON  

OPS 
Still Imagery Video 

√ Item # 
Track # Rqmts 

DCS PLB CC Dnlk 
Notes 

 1. 
 

10A-5 
 

PAO Coverage IVA 760 
28-70mm 
If exterior: 

Flash ON/OFF – OFF 

As desired 
WVS 

PD100 
As desired 

LIVE 
(if avail) 

Plan for end of day crew choice 
video, DCS stills 

Trunnions and Keel Covers  2. 
 

10A-19 • Imagery of trunnions and keel 
thermal covers install 

EVA 760 
28mm 

    

MISSE PEC 3,4 

• Deployed 

 3. 
 

10A-14 

• During retrieval, take two 760 
images of both RAM and 
Wake side of PEC 
w/different angles in sunlight

EVA 760 
28mm 

WVS,B,C,D, 
ELB,EE, 
SSRMS 

  Use WVS if crew in vicinity; use 
SSRMS if SSRMS in vicinity 

PMA2 Relocation Tasks 

• Jettison Node 2 ACBM Cover 

 4. 
 

10A-13 
10A-24 

• Demate PMA2/Lab Umbilicals
 
• ACBM Sealing Surface 

Inspection 

 WVS,B,C,D, 
ELB,EE, 
SSRMS 

  Document Crew EVA activities 
 
Obtain imagery to determine 

jettisoned ACBM Thermal 
Cover trajectory 

 
Obtain imagery of 

demated/stowed OMA2/Lab 
umbilicals 
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P/TV07   EVA (Continued) 

OPS (Continued) 

Still Imagery Video 
√ Item # 

Track # Rqmts 
DCS PLB CC Dnlk 

Notes 

P6 Activation 

• Release of P6 fwd 
cinches 

• Deployment,activation of 
P6 PVR 

LIVE  5. 
 

10A-15 

• Configured P6 elements 
and deployment of P6 
(CHs 2B,4B) SAWs 

 B,C,D,ELB,EE  

LIVE 
(Replay) 

Imagery needed to determine 
if damage would prevent 
retraction 

Node 2 External H/W 

• Handrails (up to 11) 

 6. 
 

10A-17 

• WIFs (up to 3) gap 
spanner 

 WVS  LIVE  

Node 2 to Node 1  7. 
 

10A-16 • Port CBM 
 WVS  LIVE  

P6 from Z1 to P5 Relocation  8. 
 

10A-18 • P6 to P5 install video of 
ready-to-latch indicator 
and final config of 
mating surface after 
bolts driven 

 WVS  LIVE  

Node 2 Trunnion and Keel 
Pin Covers 

 9. 
 

10A-19 • Closeout video of final 
cover install 

 WVS  LIVE  

Node 2 Pwr and Data 
Grapple Fixture (PDGF) 

 10. 
 

10A-20 • Final PDGF install 

 WVS  LIVE  

S1 Radiator Outer Pnls 
Deploy 

 

• S1 radiator outer pnl 
deploy 

REPLAY 

 11. 
 

10A-21 

• Final SFU harness 
electrical connectors 

EVA 760 (if reqd) 
28mm 

WVS  

LIVE 

If WVS unavailable, 760 reqd 
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P/TV07   EVA (Concluded) 

OPS (Concluded) 

Still Imagery Video 
√ Item # 

Track # Rqmts 
DCS PLB CC Dnlk 

Notes 

 12. 
 

10A-22 

MBSU on ESP-2 EVA 760 
28mm 

WVS  LIVE Wireless/Still photography 
callouts in EVA procedures 

ATV Docking Pwr Reconfig 
• S0/N1 SM power cable 

 13. 
 

10A-23 • PMA1/FGB M-jumpers 

 WVS   Obtain closeout of SM Pwr 
Cable PMA/FGB H Jumper 
config 

 14. 
 

10A-25 

Centerline Berthing Camr 
System (CBCS) 

IVA 760 WVS,ELB,EE   Document final config of S0 
4BC RPCM 

Lab External Outfitting of Pre-
positioned Gap Spanners 
• CETA Light temp stow 
• Node 2 WIFs 
• Node 2 Zenith ACBM 
• 4 Node 2 Radial hatch 

latch; Pins 

 15. 
 

10A-26 

• Node 2 NADID CBM 
Cover flap ‘open’ 

 WVS  LIVE 
WVS 

Obtain imagery of temp install 
config of Lab outfitting H/W 

 16. 
 

10A-31 

Closeout Imagery of all 
Thermal Cover Configs 
Manipulated to Accomplish 
Tasks 

 WVS,A,B,C,D, 
ELB,EE 

 LIVE 
WVS 

Closeout imagery critical to 
thermal rqmts and 
integrated performance of 
vehicle 

 17. 
 

10A-27 

Temp Stow PMA2/LAB 
SSPTS Cables 

 WVS,A,B,C,D, 
ELB,EE 

 LIVE 
WVS 

Obtain imagery of temp stow 
config of PMA2/LAB SSPTS 
cables 

 18. 
 

10A-28 

P1 Radiator Prep for 
deployment 

DCS PLB Camr as 
reqd 

   

 19. 
 

10A-30 

C/O of Lab Receptacles 
NLGL 

 WVS    
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P/TV07   EVA (Concluded) 

If operations temporarily suspended, perform DEACTIVATION as reqd 
If operations completed, go to DEACTIVATION 
 

DEACTIVATION 

 1. IVA DCS 760 
Pwr – OFF 
√Flash ON/OFF – ON 
Download images 
Start batt recharge as reqd 

 
 2. TV System 

Perform PWRDN (Cue Card, WVS) 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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P/TV08   EXTERNAL SURVEY 
SCENE SYNOPSIS 

Scene contains procedures for documenting STS,ISS external structures w/still photos during general survey activities 
 

SETUP 

 1. 760 Camr Configuration for OMS Pod Survey 
 

If Sunlit OMS Pod, config 760 Manual Mode 
Lens – 80-200mm at 200mm 
Pwr – ON 

√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
√ISO – 100 
√BKT – Disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – M 

SS – 1000 
AF Area Mode – [ ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min,locked 

f/stop – F8 
Flash Settings 

ON/OFF – OFF 

  P/TV08 
EXT SURVEY       

~ 
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P/TV08   EXTERNAL SURVEY (Continued) 

SETUP (Continued) 

 1. 760 Camr Configuration for OMS Pod Survey (Concluded) 
  

 
  If Earthshine OMS Pod, config 760 Program Mode 

Lens – 80-200mm at 200mm 
Pwr – ON 

√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
√ISO – 100 
√BKT – Disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [ ] (no “+”) 
Meter – Spot 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min,locked 
Flash Settings 

ON/OFF – OFF 
 

~ 
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P/TV08   EXTERNAL SURVEY (Continued) 

SETUP (Concluded) 

 2. 760 Camr Config for ISS Still Survey (760 Shutter Priority Mode) 
 

Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 

ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – S 

SS – 500 
AF Area Mode – [   ] (no “+”) 

 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – OFF 
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P/TV08   EXTERNAL SURVEY (Continued) 
OPS 

Still Imagery Video √ Item # 
Track # 

Rqmts 
DCS PLB CC Dnlk 

Notes 

 1. OMS Pod Survey 
• 50 percent mapping of both 

OMS pods and vertical 
stabilizer w/emphasis on 
Black Tile areas 

760 
80-200mm @ 200 

(400mm) 

 

Download images to MCC once 
complete 

ISS Still Survey 
• Surfaces 
• Solar Panels 
• Handrails 
• MISSE 
• SVS Targets 
• P6,P4,S4 Trusses 

Including: 
– Rads/baseplates 
– SAWs (in/outboard SABB 

insulation degradation) 

760 
50mm 

(80-200mm @ 200) 
 

 
 

 
 

 
 

Map ISS surfaces w/10% overlap 
from all Flt Deck windows 

 2. 
 

10A-8 
 

• Plasma Arcing Effects  
 

 
 

 
 

 
 

Map specified area of Lab MMOD 
shield w/10% overlap from W7(W8): 
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P/TV08   EXTERNAL SURVEY (Continued) 

OPS (Continued) 

 

Priority of ISS Photographic Targets During Docked Phase: 
1. P6, P5, P3/P4, P1, S1, S3/S4, S5, Node 2, ESP2, 

Joint Airlock, MISSE 3 and 4, S1, Solar Arrays – W1, 
W6 (special emphasis on newly installed 
components) 

2. Node 2, S0, Lab – W7,W8 
3. PMA2 – W9,W10 
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P/TV08   EXTERNAL SURVEY (Concluded) 

OPS (Concluded) 

If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. DCS 760 
Exp Mode – P 
PWR – OFF 
Flash ON/OFF – ON 
Start Batt recharge as reqd 
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REFERENCED PROCEDURES 
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DCS 760 
760 PROGRAM w/FLASH .......................................................................................................................................................................... FS 2-8 
760 CREW PHOTO .................................................................................................................................................................................... FS 2-8 
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CENTERLINE (C/L) CAMR 
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MINI-CAM 

ENTRY VIDEO SETUP 

 

jsc48037_120_015r3.cvx
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MINI-CAM (Continued) 

ENTRY VIDEO SETUP (Continued) 

 1. Remove the “Entry” Ziploc bag from the DTV Bag 
 
 2. Config Mini-Cam,VTR for Audio,Video Recording 

Config H/W per dwg, 2-3 
 

 a. Config HUD Mini-Cam w/12mm Lens 
HUD   Using two (2) captive screws, attach HUD Brkt to installation holes for protective cover w/HUD Brkt tab pointing up 
 Brkt/Cam 

Attach Tie Wrap thru holes on captive screws to prevent screw from coming loose; cut off extra length on Tie Wrap 
 

Attach Mini-Cam Extension Cable to Mini-Cam 
 

12mm Lens   Focus – ∞ 
Aperture – f/5.6 

 
Velcro Mini-Cam w/12mm Lens to HUD Brkt.  (Top of black Velcro on front of Camr should be at top edge of HUD Brkt.  
Only yellow Velcro should be visible above HUD Brkt) 

 
 b. Config in-cabin Mini-Cam w/3.5mm Lens 
 

3.5mm Lens   Aperture – f/1.8 
 
 c. Config additional Mini-Cam H/W 
 

L10:A1   AVIU 
  SYNC/VIDEO – VIDEO 
  HI-Z/75 – HI-Z 
  PWR SELECT – HI 

 
O19    √TV PWR – ON 

 
PS ATU   Config audio as reqd for entry audio 

 
L10 (MUX)   VTR/CC PWR – on (LED on) 
L10 (VTR)     √ON/STANDBY LED – green 
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MINI-CAM (Concluded) 

ENTRY VIDEO SETUP (Concluded) 

   Acquire four (4) V10 Li-ION Batts 
 

NOTE 
One Batt will be used on V10 for system C/O, second is 
spare.  Batts will be removed after C/O and used for Entry 

 
V10   Install fresh Batts (two) 

  PWR – ON 
√HUD 12mm Lens/Mini-Cam producing good video 

 
Change config to in-cabin 3.5mm Lens/Mini-Cam 
√In-cabin 3.5mm Lens/Mini-Cam producing good video 

 
V10   PWR (two) – OFF 

 
L10 (VTR)   ON/STANDBY pb – push (red LED off) 
L10 (MUX)   VTR/CC PWR – off (LED off) 

 
O19   TV PWR – OFF 

 
NOTE 

TV,VTR pwr will be re-enabled per ENT AFT FLT DECK 
CONFIG 15 (DEORB, NOMINAL DEORBIT PREP); recording 
will be initiated via ENTRY C/L 

 
Start w/3.5mm Lens/Mini-Cam video in-cabin and reconfig for 12mm Lens/Mini-Cam when exterior scene available 

 
When exterior avail: 

Focus – Adjust per V10 
Aperture – Adjust per V10 
If needed, turn down brightness on HUD display 

 
Turn off V10 when not needed 
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LASER CAMR SYSTEM (LCS)/INTEGRATED SENSOR INSPECTION SYSTEM DIGITAL CAMR (IDC) 

LCS/IDC (HEATER ONLY MODE)/(OPERATIONAL PWR MODE) DATA AND PWR INTERFACES 
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LASER CAMR SYSTEM (LCS)/INTEGRATED SENSOR INSPECTION SYSTEM DIGITAL CAMR (IDC) (Concluded) 

PTU 2/MAIN BUS B SYSTEM DETAILS 
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jsc48037_PTU2_134e.cvx
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DCS 760 

SETUP 

760 PROGRAM w/FLASH 760 CREW PHOTO 760 EXPOSURE MATCH 

Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct 

Lens – 28-70mm 
Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
√ISO – 100 
√BKT – Disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – A 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – Selftimer ‘ ’ 
Body Focus Mode – S 
Lens Focus Mode – A 
Aperture – Min, locked 

f/stop – 8 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct 

Remote Release – Install 
Multiuse Brkt (clamp) 
Focus 
Body Focus Mode – M 
Frame, Fire 

Lens – 17-35mm @ 20mm 
Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
√ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
√CSM – 21-1, AEL 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A 
Aperture – Min, locked 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct 

 
TECHNIQUE 
1.  Fill FOV w/Sunlit subject 
2.  Activate Camr 
3.  Exposure Lock ‘AEL’ pb – Depress,hold 

Expect values such as 250, F16 
4.  Focus, Frame, Fire 
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CENTERLINE (C/L) CAMR 

C/L CAMR INSTALL 

 1. ODS C/L Camr Config 
L12 (SSP 2) √C/L CAM PWR – OFF 

 
R12 (VPU) √SEC C/L Cap installed 

√Green Jumper – SEC C/L 
√VPU PWR – ON (LED on) 

 
MF43C Unstow PRI C/L Camr, PRI C/L TV Camr Harness Assy 

 
NOTE 

When connecting ODS C/L TV 
Camr Harness Assy, √pins to 
socket connection 

 
ODS √ODS C/L Camr Brkt mounted securely 

Mount PRI C/L Camr to ODS C/L Camr Brkt 
√Flex Duct attached to Camr brkt 

Config cable per dwg at right 
 

C/L Camr √SSF/STS sw – STS 
 

L12 (SSP 1) √cb SW PWR 1 (CB2) – cl 
L12 (SSP 2) C/L CAM PWR – SEC ON 

 
jsc48037_048r2.cvx

TV
(AW18H)

1 2

ODS
C/L

Camr

Ovhd Hatch

PRI C/L TV Camr Harness Assy
(V828–774057–004)

Pwr,SyncVideo

Wireless Video System
Interface Box

SEC C/L

VIDEO PROCESSING UNIT

SEC
C/L

(R12)

(ODS)
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CENTERLINE (C/L) CAMR (Continued) 

C/L CAMR INSTALL (Continued) 

 2. Camr Position Verification 
 

 

jsc48037_049r3.cvx

Existing
Shims for
Pitch/Yaw
Alignment

FWD

AFT

STBD
PORT

ÊÊÊ

NOTE
This view in ODS looking
up from Camr bottom

Cam r Housing
Bracket
Mounting
Subplate

Axial
Adjustment
Screw

Axial
Adjustment
Screw

TV

1 2

PRI C/L TV Camr Harness Assy (8.5 ft)
V828–774057–004

(ODS)
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jsc48037_050.cnv

CENTERLINE (C/L) CAMR (Concluded) 

C/L CAMR INSTALL (Concluded) 

 3. ODS C/L Camr Alignment Check 
Perform ACTIVATION (Cue Card, TV) as reqd 

 
A7 VID OUT MON 1(2) pb – push 
 VID IN PL2(VPU) pb – push 
 ALC pb – push 
 AVG pb – push 

 
MON 1(2) LDATA – ON 

CDATA – GRN 
XHAIR – GRN 

 
A7 Zoom to 10° ± 0.5° 

Focus to see Xhair target 
 

NOTE 
Green xhairs on monitor may move off center in 
calibration target when zooming in,out.  Xhair 
will be closest to center at full zoom in position 

 
MON 1(2) √Vertical xhairs coincide w/vertical alignment wire and are parallel.  If xhair marks overlay each other, no yaw(axial) alignment 

needed (see dwg above) 
 

√Intersection of monitor vertical,horizontal xhair falls within target circular opening from ~10-40° zoom range of Camr 
 

Report results of both alignment verifications (at 10° and 40°) to MCC 
 

 4. Deactivation 
A7 CAMR CMD IRIS – CL 
L12 (SSP 2) C/L CAM PWR – OFF 

Go to DEACTIVATION (Cue Card, TV) as reqd 
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CUE CARD CONFIGURATION 
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ACTIVATION 
A3 MON 1(2) PWR – ON (LED ON) 
A7 √TV DNLK – ENA 

TV PWR CNTL – PNL 
TV PWR CONTR UNIT – MNA(B) 
TV PWR CNTL – CMD (wait 10 sec for system initialization)  

OPERATION 
Auto Ops (Auto Exposure) 

NOTE 
√MCC has commanded sync config  

A7 TV CAMR PWR A(B,C,D,RMS) – ON (tb-ON) 
VID OUT MON 1(2) pb – push 
VID IN pb – As reqd 
If CTVC: 

ALC pb – push 
AVG pb – push 

If ITVC: 
If MAN GAIN pb not illuminated: 

TV CAMR PWR A(B,C,D,RMS) – OFF, wait 10 sec, then ON 
Repeat until MAN GAIN pb illuminated 

LT LEVEL pb – push 
DAY(NIGHT) pb – push 
ALC pb – push 
AVG pb – push 

Repeat for other Camrs as reqd  
Dnlk Ops 

Coordinate dnlk and sync config w/MCC 
Config audio as reqd  
If analog, on MCC GO: 

A7  VID OUT DNLK pb – push 
VID IN pb – As reqd 

If DTV, on MCC GO: 
L10  √Cables connected 
  (MUX)  MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
  (VIP)  PWR – on (LED on, DATA FLOW LED flashes twice) 
  (VTR)  √ON/STANDBY LED – green 

√INPUT SELECT – VIDEO 
A7  VID OUT DTV pb – push 

VID IN pb – As reqd 
L10 
  (VIP)  √DATA FLOW LED – on 
  (MUX)  √CHANNEL 3 DATA LED – on  
DEACTIVATION 

If Illuminator ON: 
Refer to Illuminator Ops and perform Illuminator OFF  

A7 PORT RMS CAMR – WRIST 
TV CAMR PWR A(B,C,D,RMS) – OFF (tb-OFF), wait 10 sec 
PORT RMS CAMR – ELBOW 
TV CAMR PWR RMS – ON (tb-on), wait 10 sec, OFF (tb-OFF)  
TV PWR CNTL – PNL 
TV PWR CONTR UNIT – OFF 
TV PWR CNTL – CMD 

A3 MON 1,2 PWR – OFF  
If DTV: 

L10 
  (VTR)  ON/STANDBY pb – push (red LED on) 
  (VIP)  PWR – off (LED off) 
  (MUX)  MUX/VTR/CC PWR – off (LED off) 

VTR/CC PWR – off (LED off) 

TV 
 

Manual Ops – CTVC/ITVC (Manual Exposure) 
CAUTION 

DO NOT LEAVE CAMRS UNATTENDED 
IN MANUAL MODE.  DIRECT SUNLIGHT 
WILL DAMAGE CAMRS  

Manual Exposure ON 
A7 MAN GAIN pb – push 

0(+12,+24) dB pb – push 
CAMR CMD IRIS – OP,CL  

Return to Auto Exposure 
ALC pb – push 
AVG pb – push 

 
MUX Ops 

NOTE 
Although dnlk/rcd is in color, MON 
will display MUX in B&W  

A7 VID OUT MON pb – as reqd 
VID IN MUX 1(2) pb – push 
VID OUT MUX 1(2) L pb – push 
VID IN pb – As reqd 
VID OUT MUX 1(2) R pb – push 
VID IN pb – As reqd 

 
For RSC ops: 

Go to LDRI/ITVC Cue Card 

  
 

TOP 
 

P/TV-1a/120/O/A

 (reduced copy) 
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Illuminator Ops 
Illuminator ON 

If Wrist Illuminator: 
R14:D(E)  √cb TV RMS CAMR/PTU – cl 

 √WRIST ILLUM/CAMR HTR – cl 
 – op, then cl 

If Elbow Illuminator 
√cb TV RMS CAMR/PTU – cl 
cb TV RMS √ELB ILLUM/PTU HTR – cl 
√cb TV RMS ELB ILLUM/PTU HTR – op, then cl 

If A(B,C,D,ELB) Illuminator: 
√cb TV A(B,C,D,RMS,ELB) CAMR/PTU – cl 
cb TV A(B,C,D,RMS,ELB) √ILLUM/PTU HTR – cl 

– op, then cl 
 
Illuminator OFF 

If Wrist Illuminator: 
R14:D(E)  cb TV RMS WRIST ILLUM/CAMR HTR – op, then cl 

If Elbow Illuminator: 
cb TV RMS ELB ILLUM/PTU HTR – op, then cl 

If A(B,C,D,ELB) Illuminator: 
cb TV A(B,C,D,RMS,ELB) ILLUM/PTU HTR – op, then cl 

If RSC Illuminator: 
Go to LDRI/ITVC (Cue Card) 

 
 

jsc48037_120_011.cvx
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ANALOG 
ACTIVATION 
CC Setup per diagram (back of cue card) 
A7 Perform ACTIVATION (Cue Card, TV), as reqd 
O19(MO58F) √TV PWR – ON  
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO  

CC PWR – VTR  
OPERATIONS 
PLBK or DNLK VIDEO 
CC Install tape, if reqd  

If audio reqd: 
CCU  If MHA, COMM PWR – ON 
ATU  PWR – AUD 

Desired Loops – T/R 
Other Loops – RCV(OFF) 
XMIT/ICOM Mode – VOX/VOX 
VOX SENS – MAX  

CC  Speaker Vol Max  
A7 VID OUT MON pb – as reqd 

VID IN FLT DECK(MIDDECK) pb – push 
CC VTR pb – REW(FF) to cue tape  
If Dnlk 

√MCC has commanded async config 
A7 √TV DNLK – ENA 

VID OUT DNLK pb – push 
 IN FLT DECK(MIDDECK) pb – push 

 
CC PLAY pb – push (green  displayed)  

If PLBK(DNLK) complete: 
STOP pb – push 

If CC ops complete, go to DEACTIVATION  
DEACTIVATION 
CC Remove, mark, stow tape as reqd 

PWR – OFF 
ATU Reconfig as desired 
O19(MO58F) TV PWR – OFF, as reqd 

Go to DEACTIVATION (Cue Card, TV), as reqd  

VTR VIA ANALOG 
ACTIVATION 

Setup per diagram (back of cue card) 
Disconnect CC Video input from AVIU J3 
Perform ACTIVATION (Cue Card, TV) as reqd 

O19 √TV PWR – ON  
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

L10 
 (MUX) √VTR/CC PWR – on (LED on) 
 (VTR) √ON/STANDBY LED – green  
OPERATIONS 
ANALOG PLBK or DNLK VIDEO 
L10 (VTR) Install tape if reqd 
 √DISPLAY SELECT – DATA  

If audio reqd: 
L10 (VIP)  PWR – on (LED on, DATA FLOW LED flashes twice) 

ATU – PBK/KEY MIC (Amber LED on) 
CCU  If MHA, COMM PWR – ON 
ATU  PWR – AUD 

Desired Loops – T/R 
Other Loops – OFF 
XMIT/ICOM Mode – VOX/VOX 
VOX SENS – MAX  

A7 VID OUT Desired MON pb – push 
VID IN FLT DECK pb – push 

L10 (VTR) REW(FF),PLAY,PAUSE pb – push as reqd to cue tape  
If Dnlk 

√MCC has commanded async config 
A7 √TV DNLK – ENA 

VID OUT DNLK pb – push 
VID IN FLT DECK pb – push  

L10 (VTR) PLAY pb – push (green • displayed)  
If PLBK(DNLK) complete: 

STOP pb – push 
If VTR ops complete, go to DEACTIVATION  

DEACTIVATION 
L10 (VTR) Remove, mark, stow tape as reqd 

ON/STANDBY pb – push (red LED on) 
L10 (VIP) PWR – off (LED off) 
ATU Reconfig as desired 
O19(MO58F) TV PWR – OFF 

Go to DEACTIVATION (Cue Card, TV) as reqd  

DIGITAL 
ACTIVATION 

Setup per diagram (back of cue card) 
L10 (MUX) √VTR/CC PWR – on (LED on) 
L10 (VTR) √ON/STANDBY LED – green 
 
OPERATIONS 
PLBK or DNLK VIDEO 
L10 (VTR) Install tape, if reqd  
 √DISPLAY SELECT – DATA 
 

If Index Search reqd: 
Remote   √ID – VTR4 

SEARCH MODE pb – push (INDEX SEARCH 
mode displayed) 

|  (  | ) pb – push to move highlight bar to 
desired GMT start 

When VTR auto-cue complete, green • 
displayed: 

PAUSE pb – push 
 If playback time not displayed on DSR-25 LCD cycle 

“DATA CODE” repeatedly until time displayed 
L10 (VTR) REW(FF),PLAY,PAUSE pb – push as reqd to cue tape  
If Dnlk 
L10 (MUX) MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
√CHANNEL 3 DATA LED – on  

L10 (VTR) PLAY pb – push (green • displayed) 
If PLBK(DNLK) complete: 

STOP pb – push 
If VTR ops complete, go to DEACTIVATION  

DEACTIVATION 
L10 (VTR) Remove, mark, stow tape as reqd 

ON/STANDBY pb – push (red LED on) 
L10 (VIP) PWR – off (LED off) 
L10 (MUX) MUX/VTR/CC PWR – off (LED off) 
 VTR/CC PWR – off (LED off) 

Go to DEACTIVATION (Cue Card, TV) as reqd  
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ANALOG PLAYBACK 

 

VTR VIA ANALOG PLAYBACK 

 

DIGITAL PLAYBACK 
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P/TV-3a/120/O/A

ET PHOTO
DCS 760  DCS 760

 
LENS SETTINGS 

 
√LENS APERTURE RING – MIN, LOCKED 
√LENS FOCUS MODE – M 

 
CAMR SETTINGS 

 
PWR – ON 
REAR LCD 
√BATT ICON FULL 
√ISO – 100 

TOP LCD 
√EXP MODE – M 
√SS – 1000 
√F/STOP – 8 

DIOPTER – ADJUST 
√FRAME ADVANCE – S 
√BODY FOCUS MODE – S 

 
CRITICAL FOCUS REQD EACH FRAME 
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ET PHOTO
PD100  PD100 

 
LENS CAP – REMOVE,SECURE 

 
MODE – CAMERA 

 
OPEN LCD 
√STBY 
√1000 
√F8 
√   (FOCUS – INFINITY) 

 
√AUTO LOCK – HOLD 

 
ZOOM – WIDE TO FIND TANK, THEN TIGHT 

 
START RECORDING 

 
√LCD DISPLAYS REC 
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MEDIA ALLOCATIONS 
35mm Rolls 
100 CPos 

      54 53 52 51
50 49 48 47 46 45 44 43 42 41
40 39 38 37 36 35 34 33 32 31
30 29 28 27 26 25 24 23 22 21
20 19 18 17 16 15 14 13 12 11
10 9 8 7 6 5 4 3 2 1 

 

 
DCS 1 GB/112 shots 
1 GB EVA Flash Card 

10 9 8 7 6 5 4 3 2 1 

 

 

DVCAM 3 hr/tape 
 

     15 14 13 12 11
10 9 8 7 6 5 4 3 2 1 

 

 

MINI DVCAM 40 min/tape 
 

 209 208 207 206 205 204 203 202 201
200 199 198 197 196 195 194 193 192 191
190 189 188 187 186 185 184 183 182 181
180 179 178 177 176 175 174 173 172 171
170 169 168 167 166 165 164 163 162 161
160 159 158 157 156 155 154 153 152 151
150 149 148 147 146 145 144 143 142 141
140 139 138 137 136 135 134 133 132 131
130 129 128 127 126 125 124 123 122 121
120 119 118 117 116 115 114 113 112 111
110 109 108 107 106 105 104 103 102 101
100 99 98 97 96 95 94 93 92 91
90 89 88 87 86 85 84 83 82 81
80 79 78 77 76 75 74 73 72 71
70 69 68 67 66 65 64 63 62 61
60 59 58 57 56 55 54 53 52 51
50 49 48 47 46 45 44 43 42 41
40 39 38 37 36 35 34 33 32 31
30 29 28 27 26 25 24 23 22 21
20 19 18 17 16 15 14 13 12 11
10 9 8 7 6 5 4 3 2 1 
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CAMR ADJUSTMENTS ANTENNA LOCATIONS 
ADJUST BRIGHTNESS 

Course Adjustment 
PGSC Select Page – RF Camera 

Lens Iris Control – cl(op) 
 

Fine Adjustment 
PGSC Select Page – RF Camera 

Electronic Shutter – Manual 
Brightness – Dec(Inc) 

(# to right:  100 = brightest; 0 = darkest) 
 
DARK SUBJECT 

PGSC Select Page – RF Camera 
√Advanced Controls displayed 

Automatic Gain Control – Enabled 
(Disabled preferred) 

 
PWRDN 

For all lens (three) on each RF Camera Assy: 
PGSC Lens Iris Control – Close until view black 
 

Sel RF Camr 1,2 – None (black “OFF”) 
V10 √Test Pattern displayed (color bars w/“No WVS 

Video”) 
PGSC Select Page – XCVR 

Transceiver 1(2) CMD Pwr – Off 
(black CMD PWR:LVL-“OFF:Min”) 

Sel File → Exit 
 
V10 STOP pb – push 

Mark,stow tapes 
PWR – OFF 

 
A7 WIRELESS VID PWR – OFF 
  WIRELESS VID HTR – OFF 
 

VIDEO SIGNAL PROBLEMS 

 For problem EMU TV: 
EMU EMU TV Pwr pb – push (no LED), wait 10 sec, push 

              (green LED) 
 
 If no joy: 
PGSC √Select Page – XCVR 
  √Advanced Controls displayed 

For XCVR w/Video problem:  IF – Narrow 
 
 If still no joy: 
A7 WIRELESS VID PWR – OFF, wait 10 sec, ON 
 
 If still no joy: 
PGSC For XCVR w/video problem:  IF – Wide 

For XCVR w/good video:  Sel RF Camr – None (black ‘OFF’) 
If video acceptable, other EMU TV interfering w/signal 
Alternately sel EMU TVs to acquire video 

 
 If still no joy: 

For XCVR with good video: 
Sel RF Camr – reselect original EVA crewmember 

For XCVR w/video problem:  Antenna – Manual 
Sel desired antenna 

 
 If still no joy: 

For XCVR w/video problem:  Antenna – Auto 
√MCC 

 
COMMANDING PROBLEM (UHF) 

If commanding of WVS not visually seen: 
PGSC Select Page – XCVR 

Sel Transceiver 2(1) CMD Pwr – On 
(green CMD PWR:LVL-“ON:Min”) 

 
 

 
P/TV-5a/120/O/A

jsc48037_108r1.cvx
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STATIC XCVR 
Condition: No comm between PGSC & PLB XCVR  
PGSC 1. √Cable connections between WIB and PGSC  
A7 2. WIRELESS VID PWR – OFF, wait 10 sec, ON  

If no joy: 
PGSC 3. Sel ‘Start’ > ‘Shut Down’ > ‘Restart’’ > ‘OK’ 

When reboot complete: 
Sel Shuttle Apps icon > WVS icon 
Sel ‘Yes’ at ‘Restore To Previous Settings’ window 
RF Camera page will appear  

If still no joy: 
 4. √MCC  
STATIC RF CAMERA 
Condition: No telemetry and video received by PLB XCVR from EMU TV  
EMU 1. √EMU TV Pwr pb pushed (green LED)  

If no joy: 
PGSC 2. √Correct RF Camera selected via pulldown menu 

√RF Camera (two) – ON (green “ON”) 
If not ON: 

RF Camera (of static EMU TV) – sel “None” via 
pulldown menu, then sel original EMU TV  

If still no joy: 
 3. RF Camera 1(2) – sel ‘None’ 

Perform CAMR ID ASSIGNMENT 
Reattempt RF Camr selections  

If still no joy: 
 4. √CMD PWR:LVL - green “ON:Min” for XCVR 1(2) 

If not ON, 
Select Page – XCVR 
Transceiver 1(2) CMD Power – On  

(green CMD PWR:LVL - “ON:Min”)  
If still no joy: 

EMU 5. EMU TV Pwr pb (of static EMU TV) – push (no LED),  
    wait 10 sec, push (green LED)  

If still no joy: 
6. √MCC 

BAD CAMERA ID 
Condition: Mismatch between EMU TV Camera ID and software camera ID  
PGSC 1. Select Page – XCVR 

Transceiver 1(2) CMD Power – On (green CMD PWR:LVL - “ON:Min”) 
Sel RF Camera 1,2 – None 
Sel File > Assign Camera ID 

√Camera IDs match data under CAMR ID ASSIGNMENT 
If not a match, 
 Highlight entry, then sel ‘Delete Entry’ option 
 Perform CAMR ID ASSIGNMENT 
 Sel RF Camera 1,2 – EVA crewmembers  

If still no joy: 
 2. √MCC  
TEMP ALERT (blue text) 
Condition: EMU TV -35 °C to -30 °C  OR  80 °C to 85 °C range 
 PLB XCVR -40 °C to -35 °C  OR  80 °C to 85 °C range  

Select Page – Telemetry 
Identify component w/temperature alert (blue text) 

√MCC  
TEMP CAUTION (yellow text) 
Condition: EMU TV < -35 °C  OR  > 85 °C 
 PLB XCVR < -40 °C  OR  > 85 °C  

Select Page – Telemetry 
Identify component w/temperature alert (yellow text) 

√MCC 

 

CAMR ID ASSIGNMENT
Sel File → Assign Camr ID 

√All EV crewmembers listed as options on pulldown ‘Label’ menu under CAMERA ID SETUP  
If label entry reqd: 

Type label into space next to “Add Label” icon 
Sel “Add Label” icon to add to listing  

Under CAMERA ID SETUP: 
Camera Address – As reqd via left/right arrows 
Serial Number – As reqd via left/right arrows 
Label – As reqd via pulldown menu 
“In Use” Box – Check via single click 
Sel “Save Entry” icon to right of Camr ID table (top) 
√Data entry visible in Camr ID table  

Sel OK P/TV-5b/120/O/A

Camr ID Data 
Camr Address 16 18 
Serial Number 1010 1007 
Label EV1 EV2 

 (reduced copy) 
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HOOK 
VELCRO 

PLBD VTR RECORDING 
 
L10 √VIP,VTR covers removed  
R1 √PL AUX – ON  
MA73C:E cb AC2 PL3Φ – cl  

√Cables config’d per dwg (back of cue card)  
L10 
 (MUX) VTR/CC PWR – on (LED on)  
 (VIP) √ATU – REC 

√CCTV VIDEO IN – J3 
PWR – on (LED on, DATA FLOW flashes twice)  

 (VTR) √ON/STANDBY LED – green  
√Switches set to white dot (seven)  
√COUNTER SELECT – COUNTER (TC)  
√Tape installed (tape icon LED on)  

Set GMT: 
DISPLAY SELECT – MENU 
↓ pb – ETC, EXEC pb – push 
↓pb – CLOCK SET, EXEC pb - push 
Use ↓, ↑,EXEC to set Y,M,D,hr,min to GMT 
DISPLAY SELECT – DATA  

If Audio desired: 
A15   Connect DTV Audio Cable  
L9   PS AUD PWR – AUD 

Desired Loops – RCV, Vol tw 5 
Other Loops – OFF  

A7 VID OUT DTV pb – push 
VID IN pb – as reqd  

L10 
 (VTR) REC pb – push, hold 

PLAY pb – push, simo (red dot displayed) 

TOP 
 

P/TV-6a/120/O/A

 (reduced copy) 
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TOP 
BACK OF ‘PLBD VTR RECORDING’ 

P/TV-6b/120/O/A

UNBAL
J4

M U X

VTR

ATU

V T R/CC MUX/VTR/CC

ACT

MUX
BYPASS

IEEE 1394

V IP REC

BAL
J3

J3

AUDIO IN/OUT

VTR
MONITOR

VIP OUT

VTR IN

VTR OUT

CCT
VIDEO IN

jsc48037_118_020.cvx

DTV Audio Cable (25 ft)

 (reduced copy) 
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ACTIVATION 

1. Config CCTV Sys 
A7 √ACTIVATION (Cue Card, TV) performed 
L10 (MUX) √MUX/VTR/CC PWR – on (LED on) 

√Cabling from VTR OUT port to DTV V10 
R12 (VPU) √VPU PWR – ON (LED on) 

√Green Jumper – LDRI/ITVC 
MON 1,2 L-DATA – ON 
 C-DATA – GRN 
 X-HAIR – GRN 

 
2. Apply SPEE Pwr 

A8L √STBD RMS HTR (two) – OFF 
R12 (OPP) √cb OBSS SW PWR – cl 

√OBSS SW PWR – ON 
R12 (OBSS) SPEE PWR – ON 
A6U EVENT TIMER CNTL – STOP 
 EVENT TIMER – RESET 
 EVENT TIMER CNTL – START  

(15 min LDRI calibration warmup) 
 
3. Config RSC Illum to HI 

A7 VID OUT MON 1(2) pb – push 
VID IN C pb – push 

 PAN/TILT – Adjust to see RSC Camr 
R12 (OBSS) SPEE PWR – OFF, wait 10 sec, then 

ON  
MON 1(2) √RSC illum on HI (three rings) 

 
4. Enable ITVC 

R12 (OBSS) ITVC ENA – ON 
A7 VID OUT DTV pb – push 

VID IN PL 2(VPU) pb – push 
If MAN GAIN pb not illuminated: 

R12 (OBSS) ITVC ENA – OFF, wait 10 sec, then 
ON 

Repeat until MAN GAIN pb 
illuminated 

A7 LT LEVEL pb – push 
DAY (NIGHT) pb – push 
ALC pb – push 
AVG pb – push 

V10 √ITVC video displayed 
 
5. Verify LDRI Powered 

A7 VID OUT MUX 1 L pb – push 
VID IN MIDDECK pb – push 
LDRI MODE 6 pb – push 

V10 √Flickering LDRI w/rounded corners 
A7 LDRI MODE 2 pb – push 
V10 √ITVC video displayed 
A7 VID OUT DTV pb – push, to return to 

ITVC control 

GENERAL LDRI CONTROL 

A7 VID OUT MUX 1 L pb – push 
VID IN MIDDECK pb – push 

 
Mode 1 (default at pwrup) 
A7 LDRI MODE 1 pb – push 
MON 2 √ITVC video displayed 
 
Mode 2 
A7 LDRI MODE 2 pb – push 
MON 2 √ITVC video w/illum displayed 
 
Modes 3 (4,5,6) 
A7 LDRI MODE 3(4,5,6) pb – push 
MON 2 √LDRI w/rounded corners displayed 

To adjust brightness: 
A7  CAMR CMD IRIS – OP,CL, as reqd 
 
PAN/TILT OPS WITH LDRI ACTIVE 

NOTE 
When adjusting pan/tilt in Modes   
3(4,5,6), ITVC FOCUS (ZOOM, 
IRIS) cntls  functional 

 
A7 VID OUT MON 2 pb – push 
 VID IN PL2(VPU) pb – push 

CAMR CMD PAN,TILT – as reqd 
VID OUT MUX 1 L pb – push, to return to LDRI cntl 
 

DEACTIVATION 

A7 VID OUT MUX 1 L pb – push 
VD√IN MIDDECK pb 
LDRI MODE 1 pb – push 

 
R12 (OBSS) ITVC ENA – OFF 

SPEE PWR – OFF 
A6U EVENT TIMER MODE – UP 
 EVENT TIMER CNTL – START 
 
 
 

LDRI MODE SUMMARY 

Mode 1 – Standby 
• ITVC video 
• LDRI in standby 
 
Mode 2 – Illuminator 
• ITVC video w/illum 
• LDRI laser active, LDRI camera  

inactive 
 
Mode 3 – 2D 
• LDRI 2D video 
• Similar to ITVC video 
 
Mode 4 – 2D Gamma 
• LDRI 2D video w/Gamma Black 

Stretch 
• Similar to ITVC video 
 
Mode 5 – 3D 
• LDRI 3D video 
• Flicker on MON 
 
Mode 6 – 3D Gamma 
• LDRI 3D video w/Gamma Black 

Stretch 
• Flicker on MON 

 
 

 

TOP 
 

P/TV-7a/120/O/B

HOOK 
VELCRO 

LDRI/ITVC HOOK 
VELCRO 
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RSC CAMR OPS 

NOTE 
Camr nominally pwrd in Block 4 of PI C/L 

 
R12 (OPP) cb OBSS SW PWR CB1 – cl 

OBSS SW PWR – ON 
R12 (OBSS) RSC PWR – ON 
 
RSC ILLUMINATOR OPS 

NOTE 
RSC illuminator OFF when SPEE PWR 
sw initially taken to ON.  A cycle of the 
SPEE PWR sw takes RSC illuminator to 
HIGH.  Subsequent pwr cycles take 
illuminator to MED, LOW, OFF and then 
back to HIGH.  Config may req alt Camr 
view of RSC 

 
R12 (OBSS) √SPEE PWR – ON 

√RSC PWR – ON 
ITVC ENA – OFF 

A7 VID OUT MON 1(2) pb – push 
VID IN A(B,C,D) pb – push 
PAN,TILT – Adjust to see RSC Camr 

 
NOTE 

SPEE pwr cycle will reset LDRI/ITVC to 
Mode 1 and reset the PTU angles 

 
R12 (OBSS) SPEE PWR – OFF, wait 10 sec, then ON 
MON 1(2) √RSC illum on 
 

To cycle thru illuminator modes: 
R12 (OBSS)   SPEE PWR – OFF, wait 10 sec, then ON 
 

Perform LDRI/ITVC ACTIVATION, step 4 
 
Return to original LDRI/ITVC mode, continue 

ops 
 

CONTINGENCY LDRI CLEARANCE VIEW 

NOTE 
Do not apply RMS brakes 

 
A8U AUTO SEQ – STOP (READY lt on) 
 
L10(VTR) STOP pb – push (no red •) 
 
A7 VID OUT MUX 1 L pb – push (MIDDECK lt on) 
 LDRI MODE 3(4) pb – push (steady LDRI video) 
 
 VID OUT MON2 pb – push 
 VID IN PL2(VPU) pb – push 
 
 Record PTU Pan _________ and Tilt _________ 
 
 CAMR CMD PAN/TILT – HI RATE (LO within 10°) 
 CAMR CMD PAN: 0 (left, to hard stop) 
 CAMR CMD TILT: 0 (up, to hard stop) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Note clearance thru LDRI FOV 

LDRI 
 
 Return PTU to Pan and Tilt values recorded above 
 
 VID OUT MUX 1 L pb – push (MIDDECK lt on) 
 LDRI MODE 6 pb – push (flickering LDRI video) 
 
 VID OUT MON2 pb – push 
 VID IN pb – as desired (not PL2) 
 
L10(VTR) REC pb – push, hold 
 PLAY pb – push, simo (red •) 
 
A8U AUTO SEQ – PROCEED (IN PROG lt on) 
 

LDRI PAN/TILT RESET 

Reset PTU 
A7 VID OUT MON2 pb – push 
 VID IN PL2(VPU) pb – push 
 
CAMR CMD PAN/TILT – HI RATE 
CAMR CMD PAN – L (to hard stop) 
CAMR CMD TILT – UP (to hard stop) 
CAMR CMD PAN/TILT – RESET 
 

 

TOP 
BACK OF ‘LDRI/ITVC’ 
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LCH ACTIVATION 
 Activate SSPTS APCU 2 
A15 √PTU 2 tb – on 
 APCU 2 OUTPUT – ON 
 APCU 2 CONV – ON 
 
 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS:  123V to 126V 
 PTU 2 APCU √OUTPUT – ON 
 
LCC ACTIVATION 
1. LCC Setup 

 √Hardware and cables configured per diagram below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. LCC Startup 

A31p PGSC Pwr – ON 
 Sel ‘Shuttle Apps’ > ‘LCC’ (Wait 2-3 min from APCU CONV – ON  for 

GUI Status)  
 √Laser off – blue 
 √Comm – green 
 If Laser off and Comm status not correct:  √MCC 

3. Verify LCC Desktop Video 
MO58F √TV PWR – ON 
AVIU √HI-Z/75 – 75 
 PWR SELECT – LO 
CC PWR – OFF  
 

3. Verify LCC Desktop Video (concluded) 
A31P Minimize all programs 
 Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘ENABLE DESKTOP DOWNLINK’, ‘ATI Property Page’ displayed 
 Sel ‘Yes’ 
 Maximize program windows as desired  
A7 VID OUT MON1(2) pb – push 
 VID IN MIDDECK pb – push 
A3 √LCC desktop displayed on MON1(2)  

* 
* 

If LCC Desktop not displayed 
√MCC  

*
* 

4. Verify GMT 
A31p √GMT on GUI lower right-hand side within 3 sec of SM-GPC GMT  

* 
* 
* 

If GMT not within 3 sec of SM GPC:
Sel ‘Tools’ > ‘Set GMT’  
Adjust GMT as reqd 
Sel ‘Apply’ > ‘OK’ 

*
*
*
 

OPERATION 
NOTE 

PDRS OPS will call for appropriate scan steps on LCC.  
MCC may have limited insight if desktop dnlk avail  

1. Load Database (if reqd) 
 √MCC for desired LCS database 
 √’DB Name’:  Field on upper left-hand side of LCS GUI  

* 
* 
* 

If ‘DB Name’ incorrect: 
Sel ‘Load Database…’ from File menu 
Sel MCC desired database file 
Sel ‘OK’ 

*
*
*

 
2. LCS System Status  

LCS SYSTEM STATUS 
Laser On/Off Comm LCS State 

Laser ? (gray) No Comm 
(yellow) 

Unknown or Keep Alive Heater Only Mode 
( No LCC to LCH Network Connection) 

Laser Off (blue) Comm (green) Configuration 
(Waiting for user command) 

Laser On (green) Comm (green) Operational 
(Scan in progress) 

 
 While Scan in progress (‘Scan Status’ counter incrementing): 
 √Laser On – green 
 √Comm – green 
 √Scan Display – updating 
 √Temp – green 
 √Elec – green 
 Scan complete when ‘Scan Status: Complete’ displayed  
 If LCS system status out of config, perform appropriate 

TROUBLESHOOTING section of this cue card 

 
P/TV-8a/120/O/C

LCS 

(For SSPTS APCU 2 flights only) 
(reduced copy) 
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LCC DEACTIVATION 

NOTE 
Shutting down LCC software also puts LCH in 
keep-alive heater mode.  No LCH scans/insight or 
IDC ops available.  APCU Converter pwr cycle 
reqd to reinitialize LCH for scanning and IDC ops 

 
1. LCC Software Shutdown 

A31p Sel ‘File’ > ‘Exit’ 
 When 'Shutdown' dialog box opens: 
 √'Shutdown LCH and Exit LCC Software' selected 
 Sel 'OK' 
 When 'Shutdown?' dialog box opens: 
 Sel 'OK' 

 
2. A31p Screen Resolution Reset 

  
A31P Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘DISABLE DESKTOP DOWNLINK’, ‘ATI Property Settings’ 
 Sel ‘Yes’ 
 Arrange program windows as desired 

LCH DEACTIVATION 

CAUTION 
Deactivating SSPTS APCU 2 will remove 
critical keep-alive pwr to LCH and IDC.  
Pwr must be reapplied within 105 min 

 
1. Deactivate SSPTS APCU 2/LCH 
 

A15 APCU 2 CONV – OFF 
 

 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS:  <10V 

 
 APCU 2 OUTPUT – OFF 

TROUBLESHOOTING 

Temp or Elec Status Yellow  
A31p Sel ‘System’ page 
 Report ‘Elec’ or ‘Temp’ values backlit in yellow to MCC  
 
Comm Status Yellow and LAN2 Network cable unplugged (red X on A31p system tray) 
 

NOTE 
LCC GUI Comm status will be yellow and A31p Local Area Network 
status (w/red X on A31p system tray) cable unplugged tool tip will 
appear if LCH is in keep-alive heater mode 

 
A31p If unexpected red X w/Local Area Network Connection tool tip shown on A31p 

system tray: 
 
 
 
 
 
 
R12 √OPP to LCC Cable connected to LCS CMD/TLM(J107) port 
A31p √OPP to LCC Cable connected to LCC RJ45 port 
 Exit LCC software and shut down Windows 
 
A15 APCU 2 CONV – OFF, pause 10 sec, ON 
 
 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS: 123V to 126V 
 
A31p LCC PGSC Pwr – ON 
 √A31p internal RJ45 Network Interface Card LED green 
 Perform LCC ACTIVATION, step 2 
 
 √Local Area Network Connection 2 status icon (with red X) in Windows system 

tray not displayed 
 √MCC if LCC GUI Comm status still yellow 

 
Message Area Entry 
 Report LCC GUI message area log entry(ies) to MCC  

P/TV-8b/120/O/C

(For SSPTS APCU 2 flights only) 
(reduced copy) 
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IDC ACTIVATION 

1. LCC Setup 
 √Hardware configured per LCC ACTIVATION steps 1,2 (Cue Card, LCS) 

 
A31p PGSC Pwr – ON 

 
2  IDC connectivity Check 

A31p √A31p internal RJ45 Network Interface Card LED green 
 If RJ45 Network Interface Card LED not green: 
A15 APCU 2 CONV – OFF, pause 10 sec, ON 

 
 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS:  123V to 126V 

IDC SOFTWARE ACTIVATION 

1. IDC Software Startup 
A31p Sel ‘Shuttle Apps’ > ‘IDC’ 

 
2. Verify GMT 

A31p √GMT within 3 sec of SM-GPC GMT 
 

* 
* 
* 
* 

If GMT not within 3 sec: 
Double click on GMT box on GUI 
Adjust GMT as reqd 
Sel ‘OK’ on MTU Time dialogue box 

*
*
*
*

 
3. IDC Pwr on  and self test 
 

CAUTION 
Pwr off IDC when not imaging.  Pointing IDC at Sun when 
pwr on will damage Camr 

 
A31p Sel ‘Power On’  

 
 √Black and White self-test image displayed 
 √‘Waiting for User Command’ displayed 

 
* 
*
* 

If red backlit error msg displayed: 
Perform appropriate TROUBLESHOOTING 

steps on this cue card 

*
*
* 

OPERATION 

NOTE 
PDRS OPS will call for IDC image steps on LCC A31p.  Limited 
MCC real-time insight avail if configured for desktop dnlk 

 
1. Configure LDRI Illumination 

R12 (VPU) √Green Jumper – LDRI/ITVC 
A7 VID OUT MUX 1L pb – push 
 VID IN MIDDECK pb – push 
 LDRI MODE 2 pb – push 
 VID OUT MON 1(2) pb – push 
 VID IN PL2 (VPU) pb – push 
 CAMR CMD PAN/TILT – HI RATE 
 CAMR CMD PAN – L (to hard stop) 
 CAMR CMD TILT – UP (to hard stop) 
 CAMR CMD PAN/TILT – RESET 
 CAMR CMD PAN/TILT – LO RATE within 10° 
 CAMR CMD PAN – +85 (right) 
 CAMR CMD TILT – -57 (down) 

 
NOTE 

If IDC GUI GMT does not update during Ops, an 
attempt to shut down/restart A31p should be made 

 
2. Auto Exposure (AE) Ops 

A31p √‘Use AE’ checked 
 Sel ‘Scan Lo-Res’ 
 Resize and posn AE box as reqd (pause 2 sec) 
 Sel ‘Scan Hi-Res’ 
 If Scanning with no RMS Motion: 
 Sel ‘Stop Scan’ after 30 sec 
 If scanning with RMS motion: 
 Move box to maintain RCC in AE box (using keyboard arrows) 
 Sel ‘Stop Scan’ at pause point 
 √‘Waiting for User Command’ displayed 

 
3. Scenario File Ops 

A31p From Scenario File drop-list, sel appropriate lighting condition 
 
 
 
 
 
 
 
 
 

 Sel ‘Acquire Set’ 
 √‘Acquiring Set’ displayed 
 √‘Waiting for User Command’ displayed after set 

 

P/TV-9a/120/O/C

IDC 

(For SSPTS APCU 2 flights only) (reduced copy) 
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IDC DEACTIVATION 
1. IDC and Software Shutdown 

A31p Sel ‘Power off’ on IDC GUI 
 Close (X) IDC software > 'YES' 

 
2. A31p Screen Resolution Reset 

A31P Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘DISABLE DESKTOP DOWNLINK’, ‘ATI Property Settings’ 
 Sel ‘Yes’ 
 Arrange program windows as desired 

IDC HOT KEY COMMANDS 
F5 – Toggle Summary View F6 – Toggle Image Mode 
F7 – Zoom In F8 – Zoom Out 
F9 – Reset Brightness and Contrast F10 – Reset AE Box to Default 

F11 – Toggle AE Box Visibility F12 – Find AE Box 

IDC SOFTWARE ERROR MESSAGES 
Can’t connect to LCH:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  Possible heater only mode or Network failure 
 
Iport probe failed:  Perform TROUBLESHOOTING, step 2 
Condition:  Iport startup check failed.  Expected during first pwr on attempt-resend pwr on 
 
Iport not responding:  Perform TROUBLESHOOTING, step 2 
Condition:  Iport connection lost 
 
Camera not responding:  Perform TROUBLESHOOTING, step 2 
Condition:  Camera connectivity lost 
 
Image acquisition failed:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  Camera connectivity lost during imaging 
 
Network recovery failed:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  LCH network switch connection lost 
 
Bad initialization file:  Perform TROUBLESHOOTING, step 3 
Condition:  Software will not launch due to severe ini file corruption 

TROUBLESHOOTING 
1. LCC to LCH Connectivity Check 

A31p If Local Area Network Connection  (with red X) tool tip on system tray: 
 
 
 
 
 

 Reseat OPP to LCC Cable (20 ft) to LCC RJ45 port 
 √Local Area Network Connection  Speed 10 mps 
 If no connection: 
  Perform  LCH, LCC, and IDC Reset, step 2 
 Continue nominal ops 

 
2. LCH, LCC, and IDC Reset 

A31p Exit IDC software and shut down Windows 
 √OPP to LCC Cable (20 ft) connected to LCC RJ45 port and LCS 

CMD/TLM port 
 

A15 APCU 2 CONV – OFF, pause 10 sec, ON 
 

 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS:  123V to 126V 

 
A31p LCC PGSC Pwr – ON 
 √A31p internal RJ45 Network Interface Card LED green 

 
 Perform IDC SOFTWARE ACTIVATION 
 Continue nominal ops 

 
3. LCC Swap 

A31p Exit IDC software and shut down Windows 
 Swap LCC with other A31p 
 Perform IDC Activation 
 Perform IDC Software Activation 
 Continue nominal ops 

 

TOP 
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P/TV-10a/120/O/C

WLES A31p

SSV BNC to
BNC Cable

SSV to PDIP/CIP Cable

Bal/Unbal

Video

Video A (PAYLOAD)

SSV DC Pwr Cable (6 ft)

Pwr

PAYLOAD DATA INTERFACE PANEL 2 (L11)

CABIN P/L
J105 J107J101 J103DC1 DC2

(Not
Used)

Video Spare 1
(Gnd cntl)

SSV Compression Encoder BoxSSVTCS

Photoflood

Loc-Line
(w/Clamp)

AC UTIL
PWR AC1
F1(MO52J)

Digital CC Vid/Pwr Cable (15 ft)

RCA Barrel Adapter

A/V
Adapter
Cable

Wide
Conversion

Lens

Multiuse
Arm

VideoPwr

FD CC

Digital CC Vid/Pwr Cable (15 ft)

Pwr

RCA Barrel Adapter

A/V
Adapter
Cable

Multiuse
Arm

MD CC

J2
SYNC
J4

J6
MD

AVIU

J1
75
J5

LO
J3
J7

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Pwr
DTV
AVIU

DTV
V10

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

VideoAVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

AVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Video

WVS
2

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 2
AVIU

R
L
V

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
MON 1
AVIU

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

DTV Audio Cable

AVIU-CC Video Cable

jsc48038_120_001ccr6.cvx

SEC
C/L

LDRI/
ITVC

VIDEO PROCESSING UNIT

3

ON

OFFCB1

RSC VIDEO

J101 J103 J105 J107

OPP

R12

RSC Video Cable

WVS 1 TV Pwr Cable (20 ft)

WVS 2 TV Pwr Cable (20 ft)

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

PCMCIA to
WIB-Remote
Cable (6 ft)

RS-422 PCMCIA
Card/Cable Assy

FD CC TV
Pwr Cable

(10 ft)

WLES
A31p

ASC (DTV/ENT) TV Pwr Cable (10 ft)

Pwr,Sync MD TV Pwr Cable (20 ft) Video

A31p Video
Adapter

LCS Video Cable

Balanced Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

AVIU Adapter
Cable

BPSMU to CCU
Adapter Cable

Video

*

*For CC: PWR - LO
For Mini-Cam: PWR - HI

OPP-LCC
Cable

MON 2 VPU Cable

MHA MS
CCU

PLAY
WVS 2

ATU RecorderREC

PLAY

REC

Comm Cable
(4 ft)

Comm Cable
(4 ft)

WVS 1
ATU Recorder

BNC-RCA
Phono AdapterRCA Barrel

Adapter

MON 1 to RWS Cable

BNC-RCA
Phono Adapter

RCA Barrel
Adapter

MON 2 to RWS Cable

Connect to
CCTV P/L 3

as reqd

STOWAGE LOC

MF57M/Stow-n-Go

L10:A1

MS1 FDF

Vol 3B

MF57C

MA16L

A17/CC Bag

MA16D/F

MF28K
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760 PROGRAM 
In Cabin – EVA 760 CREW PHOTO 760 EXPOSURE MATCH 

“HERO SHOT” 

Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A(M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct 

Lens – 28-70mm 
Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
√ISO – 100 
√BKT – Disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – A 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – Selftimer ‘ ’ 
Body Focus Mode – S 
Lens Focus Mode – A 
Aperture – Min, locked 

f/stop – 8 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct 

Remote Release – Install 
Multiuse Brkt (clamp) 
Focus 
Body Focus Mode – M 
Frame, Fire 

Lens – 17-35mm @ 20mm 
Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
√ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
√CSM – 21-1, AEL 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A 
Aperture – Min, locked 
Flash Settings 

ON/OFF – ON 
√TTL, Matrix 
√Zoom – Auto (no M) 
Tilt – Direct  

TECHNIQUE 
1.  Fill FOV w/Sunlit subject 
2.  Activate Camr 
3.  Exposure Lock ‘AEL’ pb – Depress,hold 

Expect values such as 250, F16 
4.  Focus, Frame, Fire 

 
P/TV-11a/120/O/A

DCS SETUP

XXX F X 

P LOCK

XXX F 8 

A LOCK 

XXX F X 

P LOCK

 
(reduced copy) (reduced copy) 
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TOP 
BACK OF ‘DCS SETUP’ 

HOOK 
VELCRO 

 

ELB CAMR 
760 SHUTTER PRIORITY 

 “RNDZ and FLYAROUND 
EARTH OBS 

Lens – 28-70mm at 70 
Pwr – ON 
√Disk installed 
Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – P 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix   
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A (M/A) 
Aperture – Min, locked 

 
NOTE 

If Shutter Speed <1/60, 
 use P* to achive 1/60 

 
 

Pwr – ON 
√Disk installed 

Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – S 

SS – 500 
AF Area Mode – [   ] (no “+”) 

 
NOTE 

r Docking: Meter – Spot/Matrix 
For Undocking: MeterMatrix/Spot 

 
Meter – Matrix (Spot when ISS <1/2 frame) 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A (M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – OFF 

Lens – 400mm (as reqd) 
Pwr – ON 
√Disk installed 

Rear LCD 
√Batt 
√Frames remaining sufficient 
√White Balance – Auto 
ISO – 100 
√BKT disabled 

√Focus Area – Center, LOCK displayed 
Exp Comp – 0.0 
Exp Mode – S 

SS – 500 
AF Area Mode – [   ] (no “+”) 
Meter – Matrix 
Diopter – Adjust 
Film Adv – S 
Body Focus Mode – S 
Lens Focus Mode – A (M/A) 
Aperture – Min, locked 
Flash Settings 

ON/OFF – OFF 
 

 
P/TV-11b/120/O/A

XXX F X 

P LOCK

500 F X 

S LOCK 

500 F X 

S LOCK

 
 (reduced copy) 
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TOP 
BACK OF ‘LDRI/ITVC A7 PLACARD’ 

P/TV-12b/120/O/A
HOOK

VELCRO
HOOK

VELCRO

TOP 
 

P/TV-12a/ 
120/O/A

LDRI/ITVC 
A7 

PLACARD 

1
ITVC-VIDEO

LDRI-OFF

2
ITVC-VIDEO
LDRI-ILLUM

3
LDRI-2D
VIDEO

4
2D +GAMMA

5
3D +FLICKER

6
3D +GAMMA

+FLICKER
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NOTE 
Replace this page with four (4) pieces of blue 
K-10 stock in crew copies only 
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NOTE 
Replace this page with four (4) pieces of blue 
K-10 stock in crew copies only 

 



 

Flight Cover (trim bottom to expose tabs) 

JSC-48038-120 
FINAL, REV A 

 

PHOTO/TV 
CHECKLIST 

STS 

120
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